Last Record button: moves the cursor to the last record in the table and
keeps the cursor in the same field.
New Record button: creates a new record at the end of the table and moves
the cursor to the first field of the new record.
You can also move through a datasheet by pressing the keyboard directional
keys, pressing or clicking anywhere in the datasheet.

Adding, Updating and Deleting Records
Entering records into a datasheet is much like entering data into a
spreadsheet. You can use the arrow keys, the key and the mouse to move
from field to field in a table.
As you enter new or revised data into a table record, a pencil icon displays in
the record selector to indicate that the record contains unsaved changes.
When you reach the end of a record, you can press or to move the cursor to
the first field of the next record, and the edited record is automatically saved.
You can also press + to save changes from anywhere in the Datasheet.
To update (edit) a record, simply select the data you want to change and enter
new data. While you are editing a record, a pencil icon displays in the record
selector. Your changes are not saved until you move to another record or
press +. If you change your mind about changing the data, you can press to
abandon the changes and return the fields in the record to their original values.
To delete a record, click the row selector for the record, then press Delete.
Access displays a message box asking you to confirm the deletion.
Click Yes to confirm the deletion.

Learn the SkillIn this exercise, you will enter records and edit records
in the Vendors table and navigate the records of the Products table.
1

Restore the Access window. The GardenShop2 database should be
open.
The database currently includes six local tables: Customers, OrderItems,
Orders, OrderStatuses, Products and Vendors; and one linked table,
TopSellers.

2

Open the Vendors table in Datasheet view.

3

Press to skip over the VendorID field, which is an AutoNumber field.

4

Type: Good Earth Supplies, press , type: 21 Green Way, press , type: Ajo,
press , type: AZ, press , type: 85321, press , type: 520-555-9997, then press
to enter the first record.

23

Click inside the Description field in Record 24, then press several times.

The cursor is now located within the field and can be positioned for editing
functions.
24

Press to move to Record 23.

25

Press + to move to the last field in the last record.

26

Press + to move to the first field in the first record.

27

Close the Products table, then minimize the Access window.

Manipulating a Datasheet
While you design your fields in Table Design view, Datasheet view gives you a
considerable amount of control over how data displays. For example, you can
size and position datasheet columns without affecting the underlying data.
You can also customize the appearance of the data sheet by adding
formatting and table descriptions, inserting total rows and changing field
captions to make data easier to understand and “digest.”

Sizing and Positioning Datasheet Columns
At times you may want to resize or rearrange datasheet columns to suit your
needs. For example, suppose the datasheet contained 20 or more fields. The
screen is not large enough to display all the fields at once. If you need to work
with data in fields 1, 2 and 17, it would be cumbersome to scroll horizontally to
reach field 17.
There are several techniques you can use to make your work easier. You can:
•

Hide or unhide columns - to temporarily hide fields that you do not need
to edit so that they no longer take up space on the screen. To hide a field,
right-click the column heading in the datasheet and select Hide Fields in
the shortcut menu.

•

Resize fields – to display more or less data as required. You can resize a
field by positioning the mouse pointer over the right border of the field in
the heading row. The mouse pointer will change to a resizing icon (a
double-headed horizontal arrow intersecting a vertical line ), indicating that
you can resize the field. Click and hold the left mouse button and drag the
right border either left or right as required.

•

Rearrange fields – you can physically drag a field to another position in
the datasheet so the fields you need to edit are adjacent to one another. To
move a field, click the column heading to select the field, position the
mouse pointer over the heading for the selected field, then click and hold
the left mouse button until a thick blue line appears along the left boundary
of the field. Drag the field into the desired position, then release the mouse
button.

•

Freeze and unfreeze fields – you can freeze the first one or several
fields in a table so they do not scroll out of view when you scroll the
datasheet horizontally to the right. To freeze a field, right-click in the column
heading, then select Freeze Fields in the shortcut menu.

In the following exercise, you will use techniques to manipulate the fields in a
datasheet. Any changes you make to the datasheet affect the display of the
data only; the underlying field structure of the table remains intact.

Learn the SkillIn this exercise you will hide and unhide fields, resize
columns, rearrange columns, and freeze and unfreeze fields.
1

Restore the Access window. The GardenShop2 database should be
open.

2

Open the Customers table in Datasheet view.

In order to simulate working with a datasheet that contains too much
information to view in a single screen (or to simulate working with a very low
resolution monitor), resize the datasheet columns, making it necessary to
scroll horizontally to see all the fields.
3

Position the mouse pointer over the right border of the CustomerID field
in the column heading until the mouse pointer changes to a resizing icon,
press and hold the left mouse button and drag the right border of the
selected field about one inch to the right, then release the mouse button.

4

Resize the remaining fields so it is necessary to scroll horizontally to see
all the fields.
Your datasheet should resemble the one shown below:

Suppose you want to see only the CustomerID, FirstName, LastName and
Phone fields. You can hide individual fields one at a time, or you can select
multiple fields and hide them simultaneously.
5

Right-click the Street column heading, then select Hide Fields in the
shortcut menu to hide the Street field.

6

Click anywhere in the LastName field, then position the mouse pointer
over the City column heading, click and drag right to select the City, State
and ZIP fields, then release the mouse button.

7

Right-click in one of the selected column headings, then select Hide
Fields in the shortcut menu to hide the selected fields.

8

Right-click one of the remaining column headings, then select Unhide
Fields in the shortcut menu to open the Unhide Columns dialog box, as
shown below:

Notice that the check boxes for
the hidden fields are
unselected. You can use this
dialog box to unhide specific
fields.
9

In the Unhide Columns dialog box, select
the check boxes for the Street, City, State
and ZIP fields, then click Close. This action
unhides all the hidden fields.

Suppose you need to work with all the fields, but do not want to lose sight of
the CustomerID field as you scroll to the right. You can freeze the field so it
remains onscreen.
10

Click in the CustomerID field for any record, then press several times
until the Phone field is visible. Notice that the left-most fields scroll out of
view (if you have made the columns wide enough).

11

Press +.

12

Right-click in the column heading of the CustomerID field, then select
Freeze Fields in the shortcut menu.

13

Click in the CustomerID field for any record, then press several times
until the Phone field is visible.
Notice now that the CustomerID field does not scroll out of view.

14

Press + to scroll horizontally to the left until the FirstName field is visible
again.

Suppose you need to work with all the fields, but do not want to lose sight of
either the CustomerID field or the State field as you scroll to the right. You can
reposition the State field so it is adjacent to the CustomerID field, then freeze
both fields.
15

Click the State column heading, then press and hold the mouse button
until a thick blue line appears along the left edge of the State field.

16

Drag the selected field to the left until it is between the CustomerID and
FirstName fields, then release the mouse button. You may have to drag
the State column to the left, release the mouse, move the horizontal scroll
bar, and drag the State column to the left again. Repeat as many times as

needed to move it to the correct position.
Your datasheet should resemble the one shown below:
17

Right-click the State field column heading, then select Freeze Fields in
the shortcut menu.

18

Tab your way through the fields to see that both the CustomerID and the
State fields are frozen.

19

Right-click any column heading, then select Unfreeze All Fields to
unfreeze the fields.

20

Drag the State field back to its original position in the datasheet.

21

In the column heading for the CustomerID field, double-click the right
border of the field. Double-clicking the right border resizes the field so it
is wide enough to accommodate its widest entry. (In some cases, the
widest entry may be the field name.)

22

Resize the remaining fields in the datasheet to fit their widest entries.
Your datasheet should appear similar to the one shown below.

23

In the Quick Access toolbar click the Save button to save the changes to
the datasheet layout.

24

Close the Customers table, then open the Products table and the
Vendors table.

25

Make any necessary adjustments to the column sizes to ensure that each
column displays its widest entries.

26

Save, then close the open tables, then minimize the Access window.

Customizing the Appearance of Datasheet Data
You can customize the way tables appear in the Navigation Pane and the way
data appears in the datasheet.
Adding Table Descriptions
Every database item has properties that you can manipulate. Tables include a
description property into which you can enter descriptive text that will appear in
the Navigation Pane when objects are viewed in Detail view.

To add a table description, right-click a table in the Navigation Pane, then click
Table Properties to open a Properties sheet for the table. Enter a description
in the Description text box, click Apply, then click OK.

Changing Field Captions
The column headings that appear in the datasheet are the field names that you
defined for the table in Table Design view. However, each table field has a
caption property that you can use to change the headings that appear in the
datasheet.
You can enter a caption in the Field Properties portion of the Table Design
view window, or you can specify one in Datasheet view. To enter a caption in
Datasheet view, click in the column for which you want to enter a caption, then
click the Fields tab of the Table Tools tab in the Ribbon. In the Properties
group, click Name & Caption to open the Enter Field Properties dialog box.
The value in the Name box reflects the name of the current field. This is the
actual name of the field, as shown in the Table Design view.
The value in the Caption box is the text that displays at the top of the column in
the datasheet.
The value in the Description box displays as a hint in the status bar whenever
the field has the focus.
For example, the settings in the Field Properties dialog box shown above,
appear in the datasheet as shown in the following:
Inserting Total Rows
You can add a total row to a datasheet to perform various aggregate functions
on the values in a column. An aggregate function calculates a value across a
range of data. For example, you can use a total row to count, sum, or average
the values in a column, or use it to find the minimum or maximum value in the
column.
To add a total row to a datasheet, open the table in Datasheet view, then click
Totals in the Records group on the Home tab to insert the total row. Once the
row is inserted, click in each column for which you want to show a total, display
the drop-down list, then select a function to apply to the column.

The Sum, Average, Count, Maximum, Minimum, Standard Deviation and
Variance functions are available for fields with the Number, Decimal or
Currency data type. For non-numeric columns, only the Count function is
available.
Changing Data Formats
A data format controls the way data displays. The data format is distinct from
the data type, and applying a data format does not affect the way data is
stored in the table.
Numeric fields, for example, can display in General Number format, or as
Currency or as Euros, and they can appear in Fixed, Standard, Percent or
Scientific notation. Date fields can display as Long Date, Medium Date, Short
Date, and so on.
You can apply a format in the Field Properties portion of the Table Design
view window, or you can select a format from the Format drop-down list in the
Formatting group on the Fields tab of the Table Tools tab of the Ribbon.
Selecting a format from the Fields tab adds the format to the table definition;
that is, the format setting will be visible in Table Design view.

Learn the SkillIn this exercise, you will change field captions, change
data formats and work with total rows.
First, you will change field captions.
1

Restore the Access window. The GardenShop2 database should be
open.

2

Open the Customers table in Datasheet view.

3

Click any value in the FirstName field, then click the Fields tab in the
Table Tools tab of the Ribbon.

4

In the Properties group, click Name & Caption to open the Enter Field
Properties dialog box.

5

Click in the Caption box and type: First Name.

6

Click OK. Notice that the column heading in the datasheet now reads
“First Name”, with a blank space between the two words.

7

Click any value in the LastName field.

8

In the Properties group, click Name & Caption, click in the Caption box
and type: Last Name.

9

Click OK. The column heading for the LastName field now appears as
“Last Name”, also with a blank space between the two words.

10

Switch to Table Design view, click the FirstName field in the Field Name
column, then examine the Field Properties. Notice that First Name
appears in the Caption box, but the field name remains unchanged. In this
case, the field name is FirstName, which does not contain any blank
spaces in the name.
This is important: the field name is the actual name of the field. It is
perfectly acceptable to present user-friendly captions in the datasheet;
however, whenever you create queries, forms and reports (described in
later lessons), you must always refer to the field by its field name.
Some developers prefer to use user-friendly captions on forms and
reports, and display the actual field names in the datasheet. In this
exercise, you will not use captions for the datasheet.

11

In the Field Properties section, select the value in the Caption box for the
FirstName field, then press Delete to remove the caption.

12

Remove the caption for the LastName field as well.

13

Save the table, then switch to Datasheet view. The column headings now
reflect the field name.

14

Close the Customers table.

Next, you will change data formats.
15

Open the Products table in Datasheet view, and scroll down the UnitPrice
field. Notice that not all values display with two decimal places.

16

Click any entry in the UnitPrice field, then click the Fields tab in the Table
Tools tab of the Ribbon.

17

In the Formatting group, display the Format drop-down list and select
Fixed. All the values in the UnitPrice field now display with two decimal
places.

18

Click any entry in the QuantityInStock field and apply the Standard
number format to show thousands separators, then click the Decrease
Decimals button twice to show no decimal places.

Next, you will add a total row.
19

Click the Home tab on the Ribbon, then in the Records group, click
Totals to display the total row in the datasheet. The total row appears at
the bottom of the window, and remains visible no matter which records
you are viewing.

20

In the Total row, click in the Description column and display the dropdown list. Notice that you can use a Count function (which counts the
number of records), or change the setting to None, which will show no
total for the column. Click None.

21

In the Total row, click in the UnitPrice column and display the drop-down
list. Because this is a numeric field, you have many more choices.

22

Select Maximum to view the unit price of the highest-priced item
(175.50).

23

Select Minimum to view the unit price of the lowest-priced item (1.25).

24

Select Average to show the average unit price of all the products in the
Total row (27.66).

25

In the Total row, click in the QuantityInStock column, display the dropdown list and select Sum, if necessary, to show the total number of
pieces in inventory.

26

In the Ribbon, click Totals to hide the total row.

27

Save and close the Products table, then minimize the Access window.

Printing Datasheet Records
Access reports are designed specifically for the purpose of printing database
data. However, printing a datasheet can be useful for examining the data. You
can print an entire datasheet, or select records and print the selection.
To print a datasheet, open the table in Datasheet view, then click File to
access Backstage view. Click the Print tab, then select:
•

Quick Print - to send output directly to the default printer without making
any change

•

Print – to select a printer, specify the number of copies, and specify
whether to print all records or only the selected records

•

Print Preview – to preview and make changes to the output before
printing. From Print Preview you can adjust page orientation, margins, and
paper size.

